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IconAnimate Window
Initially, a default file called IAni1 is maximized within the IconAnimate window. You can however open or 
begin several animation files at once. The up/down arrow button at the right end of the Menu bar lets you 
reduce the size of (IAni1) so that other files can share the overall workspace within IconAnimate.

Each resizable animation window has its own resizable Script, Work and Display views. By right clicking 
on a specific view, you can display a popup menu that lets you select a command that applies to the 
current view.

The IconAnimate display contains the following components:

Title Bar
Menu Bar
Ribbon Bar
Icon Palette
Script View
Work View
Display View
Status Bar



Title Bar
The title bar contains the name "IconAnimate" and the default name of the current animation file (IAni1). 
When you save the file, you have the option of assigning it a different name.



Menu Bar
The menu bar has seven pull-down menus.    The menus allow you to create, edit, and manage animation
files, tailor the appearance of the IconAnimate window, and access online Help.



Ribbon Bar
The ribbon bar is the topmost graphic bar in the IconAnimate window. You can click on these buttons to 
quickly perform some of the more frequently used IconAnimate tasks. All of the functions in the ribbon bar
are also available through the commands in the menu bar. 



Icon Palette
The icon palette is the second graphic bar. You select an icon from the palette and build it into a script (in 
the Script view area).
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Script View
The Script view is the vertical area on the left side of the window. This is where you build the icons into a 
script. To display commands that are specific to working with icons, right click anywhere in the Script view.

Related Topics:

Building an Animation Script
Setting Icon Properties
Editing an Animation Script
Hints for Working in Different Views



Work View
The Work view is the gray area in the top right portion of the window. Every graphic file that you display in
your animation first appears in the Work view. Its called the Work view because while you are setting 
properties for the graphics you load, you often need to do work in this area to help provide values for 
certain fields. 

As an example, you may create a graphic that contains several types of arrows, with the intention of using
different animated arrows for various parts of your application. You would use a Graphic icon to load the 
entire graphic into the Work view. You would then use an Animate icon to specify the exact area of the 
graphic that you want to animate. For example, you might draw a box to select only the largest left-
pointing arrow.

Note: To display commands that are specific to the Work view, right click anywhere in the Work view.

Related Topic:

Hints for Working in Different Views



Display View
The Display view is the black area in the bottom right portion of the window The Display view serves two 
basic purposes. First, it is the area where the actual animation appears when you run it. You can run an 
animation in the default scaled-down Display view, you can make it larger, or you can maximize the view 
so that it covers the entire screen.

The second basic function of the Display view is to let you specify key information about where you want 
certain actions to occur during the animation. For example, when you use an Animate icon, you specify 
the locations (in the Display view) where you want the graphic to appear. 

Note: To display commands that are specific to the Display view, right click anywhere in the Display view.

Related Topic:

Hints for Working in Different Views



Status Bar
The status bar displays information about an item on which the cursor is currently positioned.



Hints for Working in Different Views
The different activities of building, editing, setting properties require that you perform tasks in the different 
views (Script, Work and Display).

Resizing Views
To resize views within an animation window:

1. Position the cursor over the border between two views. 
2. Drag to stretch the view that you want to be larger. 
To resize views to original proportions:

+ Click on the Tile Views button in the ribbon bar. 
Showing a Single View
In some situations, you may want to work in just one view. For example, if you are working exclusively on 
building icons in to a script, you may want to just show the Script view.

To show a single view:

1. Click on one of the three Activate Script View, Activate Work View or Activate Display View buttons in 
the ribbon bar. 
The name of the active view appears in the status bar. 

2. Click on the Maximize View button. 
The currently active view is shown in the full area of the animation window. To switch to another view click
on the appropriate Activate Script, Work or Display View button.



IconAnimate Overview
To create an IconAnimate animation file, you build special icons into a logical sequence, called a script. 
Every IconAnimate icon provides a different instruction. For example, one icon in the script may display 
an image and the next icon may animate the image across the screen. Like authoring an entire 
application, creating animation files involves the basic tasks of planning, building, setting properties, and 
editing.



Planning
When you plan your animation remember to answer the basic questions: what do you want the animation 
script to do, and how can you use IconAnimate to achieve that result.    Because the animation you create 
is made up of previously created graphics, an important part of the planning process involves creating 
and gathering the appropriate graphic files.    Some graphics will serve as the background for animation 
routines and other graphics will provide the shapes you want to animate in the foreground. 

As an example, if you planned to create a file that animates a horse galloping, you would first need to 
create graphic images that show the horse in the various stages of the gallop. Once the graphic images 
exist, you can use IconAnimate to put the images together in sequence..



Building the Animation Script
Building the script involves selecting icons from the Icon Palette and placing them in the Script view. 

To build an icon in the script:

1. Click on an icon in the palette.    
2. Move the cursor to the desired position in the script.

If you move the cursor to a position outside of the Script view, the cursor changes to indicate that this 
is not a valid build area.

3. Click to build the icon into the script.
If you decide not to use the icon, simply right click.

Note: You can also drag an icon, position it in the desired location and drop it into the script by releasing 
the left mouse button.

When you build an icon into the Script view the icon is selected (highlighted) and has several dashes to 
the right. Later, when you set the properties of the icon, the dashes are replaced by the values you 
specified. 

You can repeat the building process until you select all the icons necessary to create your script. You can 
place an icon anywhere in the script, for example, at the top, the bottom, or between two other icons. The 
order in which the icons appear in the script is essential because IconAnimate runs the script by playing 
the icons from top to bottom.    

The following icons are available:
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Setting Properties
Each icon has a dialog box associated with it that enables you to edit the properties (characteristics) of 
each icon. You open a Properties dialog box by double-clicking on an icon in the script. The dialog box 
contains all of the fields and options for the selected icon.

The Properties dialog box has different tabs to let you display and edit different properties. When you 
finish working on the currently selected icon, you can either click on the Close button or click on a 
different icon in the script. When you click on another icon, the fields and settings change to reflect the 
current icon.

You set properties for the icons within a script to customize the way they perform. For example, when you
use the Graphic icon, you can display a particular graphic. You can set properties such as the name of the
file and the screen location to use for the file.

To open the Properties dialog box:

+ Double-click on an icon in the Script view.
Note: You can also open the dialog box by selecting an icon and pressing ALT + ENTER. Or, by right 
clicking in the Script view and choosing Properties... from the popup menu.

Once the Properties dialog box is open, you can click on another icon in the script and the dialog box 
changes to reflect the currently selected icon. The dialog box remains open until you explicitly close it.

Related Topics:

How Tabs Work
Buttons in the Properties Dialog Box
Entering Values in the Properties Dialog Box



Tabs in the Properties Dialog Box
Each dialog box contains multiple tabs that separate the fields and options into logical categories. By 
default, the tab labeled General is selected when you first open the dialog box. Set properties by 
providing values for the various fields and options. When you finish working on the currently displayed 
properties, click on another tab to display and work with additional properties.



Buttons in the Properties Dialog Box
The following list describes the purpose of the buttons that appear in the Properties dialog box.

Apply 
Accepts values and options that you have entered for all tabs.

Restore
Undoes changes that you made in the fields and options of all tabs. Note that the Restore button only 
removes changes that were made since you last clicked the Apply button.

Close
Closes the Properties dialog box.

Help
Displays online Help on how to use the currently displayed fields.

Browse...
Available in some dialogs to let you search for the name of a file.

Effect...
Available in some dialogs to let you select a special effect to use in a graphic display.

Color...
Available in some dialogs to let you select a color.



Values in the Properties Dialog Box
Most fields require values such as a color, a filename, an area in the Work view, or a location in the 
Display view. Although you can type values in fields, most fields have tools to help you enter a value more
easily. 

Related Topics:

Variables
Colors
Filenames
Keywords
Work and Display View Values
Customizing the Default Values



Variables
In addition to fixed values you can also enter an IconAuthor variable in a field. If you specify a variable, 
make sure that you have previously assigned a value to the variable in the IconAuthor application that 
runs the animation. Variables only work when the animation is run in IconAuthor or in an IconAnimate 
object. Note that since variables are defined in IconAuthor , if you try and run a script that contains 
variables from within IconAnimate, an error will occur.



Colors
The Paint icon requires one or more color values. You can enter a keyword such as blue or green, or you 
can enter an RGB value. An RGB value is made up of three numbers separated by commas, such as 
0,255,127.    Each number represents the level of intensity of red, green, and blue, respectively, that make
up the resulting color.    Each intensity level value can range from 0 to 255.    0,0,0 is black and 
255,255,255 is white.

To easily select a color, click on the Color... button to display the Color Editor. When you select a color in 
the editor and click on OK, the RGB value is automatically returned to the Color field.



Filenames
Two icons require filenames. The Graphic icon requires the name of the graphic to display and the File 
icon requires the name of an animation file that you want to call from within the current animation file. You 
can type the name of the file or you can click on the Browse... button to display the Browser box. Use the 
dialog box to find the filename you want. When you double-click on a filename, it is automatically returned
to the Filename field.



Keywords
Several fields let you enter keywords. For example, the Animate icons Look tab lets you use keywords 
(such as VerySlow) to set the speed at which an item is animated. When available, keywords are located 
in a fields drop-down list box.



Work and Display View Values
Several fields require that you specify a value such as a width and height or a location in the Work or 
Display view. The name of the field indicates which view should be the source of the data. For example, 
the Graphic icon has a Display Location field which requires that you pick a point in the Display view.

To select a single point, click in the appropriate view. To obtain a width and height or an area, draw a 
rectangle in the appropriate view. The resulting values are automatically returned the appropriate field.

Note: As you draw rectangles or select points, the current mouse position appears in the status bar.



Customizing the Default Values
The IconAnimate icons come with certain default settings that you can change.You can change any 
values by selecting new ones. However, IconAnimate also lets you change the defaults themselves.

To change the defaults:

1. Open DEFAULT.ANI.
The file contains a script with one of each IconAnimate icon.

2. Change the desired settings for each icon.
3. Save the file.
4. Quit IconAnimate.
5. Restart IconAnimate.
The new defaults are now in effect.



Editing the Script
Once you build icons into a script, you can edit by removing, moving or copying icons. You can also insert
icons into your script that exist in other animation files. By changing the sequence of icons, you change 
the order in which the script is executed. 

Related Topics:

Selecting Icons
Cutting Icons
Copying Icons
Pasting Icons
Moving Icons
Deleting Icons



Selecting Icons
To select an icon:

+ Click on the icon.
The selected icon is highlighted. If the Properties dialog box is open, its tabs and fields change to reflect 
the currently selected icon. To edit a range of icons you first select the range. After the range is selected 
you can perform editing tasks such as cutting an icon, just as if you were working with only one icon.

To select a range of icons: 

1. Click on the first icon in the range you want to select.
2. Hold down SHIFT while you click on the icon you want to be last in the selected range.
The selected icons are highlighted. If the Properties dialog box is open, it changes to reflect the tabs and 
fields that are common to the currently selected icons.

To select every icon in a script:

+ Choose Select All from the Edit menu.



Cutting Icons
When you cut icons you remove them from the script and place a copy on the Clipboard.

To cut icons from the structure:

1. Position the mouse pointer over an icon or a range of selected icons.
2. Click on the Cut button or choose Cut from the Edit menu.

The icon or icons are removed from the script and copied to the Clipboard.
Note: You can achieve the same results by using the Cut command from the Edit menu or by pressing 
CTRL + X.



Copying Icons
When you copy an icon (or a group of icons) you leave the original items unchanged and insert the copy 
elsewhere in the script or within another script.

To copy icons:
1. Position the mouse pointer over the icon or over a range of selected icons.
2. Press and hold the CTRL key and press and hold the left mouse button.

If you do not hold down the CTRL key, the icons will be moved rather than copied.
3. Drag to a different position in the script (or in a script in another open animation window).
4. Release the mouse button.

The icon or icons are copied to the new position.
Note: You can also use the Copy button or the Copy command in the Edit menu to copy icons to the 
Clipboard. Select the icon or range of icons and click on the button or choose the command. A copy of the
icon or range of icons is automatically placed on the Clipboard.



Pasting Icons
When you paste an icon (or a group of icons) you insert a copy of the icon(s) stored in the Clipboard, into 
the structure. You can only paste an item if it was previously cut or copied. A small square (that represents
an icon) appears on the Clipboard to indicate that the Clipboard has an item in it.

To paste one or more icons:

1. Click on the Clipboard.
2. Move the cursor to the position in the script where you want to paste.
3. Click the left mouse button.

A copy of the icon(s) currently stored in the Clipboard is inserted into the structure.
Note: You can also use a menu command to paste icons. Choose Paste from the Edit menu (or press 
CTRL + V). Move the cursor to a valid drop position in the structure and click.



Moving Icons
You can move an icon (or a group of icons) from one position to another. This action can occur within a 
script or from one script to another.

To move icons:

1. Position the mouse pointer over the icon or over a range of selected icons.
2. Drag to a different position in the script (or in a script in another open animation window).
3. Release the mouse button.

The icon or icons are moved to the new position.
Note: You can also use the Copy button or the Copy command in the Edit menu to copy icons to the 
Clipboard. Select the icon or range of icons and click on the button or choose the command. A copy of the
icon or range of icons is automatically placed on the Clipboard.



Deleting Icons
When you delete an icon you permanently remove it from the script. A copy of the icon is not placed on 
the Clipboard. Use this function with care because icons that are deleted from the structure are not 
recoverable.

To delete icons from the structure:

1. Select an icon or a range of icons.
2. Press Delete or choose Delete from the Edit menu.

A dialog box appears that asks you to confirm the delete action.
3. Choose Yes to continue or choose No to cancel the action.

When you choose Yes the icon is removed from the script.
The dialog box that asks you to confirm the delete is optional. If you do not want the dialog box to appear 
choose Confirm Icon Delete from the Options menu.



Playing the Animation Script
You can play a single icon or play the entire script. You can also disable icons so that they do not execute 
when you play the script from within the editor.

Related Topics:

Playing a Single Icon
Playing the Entire Script
Disabling and Enabling Icons



Playing a Single Icon
You may want to play one icon to test its performance. Keep in mind that some icons depend on the result
of previous icons in order for them to play properly. For example, a graphic image must be loaded before 
it can be animated.    Therefore, the Animate icon cannot be played properly as a single icon.

To play a single icon:

1. Select the icon.
2. Click on the Run Selected Icon button in the ribbon bar.

The selected icon has diagonal lines through it to indicate that it is running.
The selected icon runs in the Display view. The word Running appears in the status bar to indicate that
the icon is executing. This is helpful if you are executing an icon that does not cause any visible 
change in the Display view. For example, if you run a Stop icon that is set to wait until the user clicks 
before continuing, the animation will continue to run until you click in the Display view.

Note: Here are three other ways to run an icon: press ENTER, right click on the icon and choose Run 
Selected Icon from the popup menu, or choose Selected Icon from the Run menu.

To stop a running icon:

+ Click on the Halt button or    the ESC key.



Playing the Entire Script
Typically you play the entire script to test it. This allows you to review the final results that the user sees 
when the animation script is included in an IconAuthor application. You can play the script in the Display 
view or you can play it fullscreen.

To play the script in the Display view:

+ Click on the Run Script in Display View button in the ribbon bar.
The currently executing icon has diagonal lines through it to indicate that it is running. The word Running 
appears in the status bar to indicate that the script is executing.

Note: Here are three other ways to run a script: press CTRL + R, right click in the Display view and 
choose Run Animation from the popup menu, or choose Animation in Display View from the Run menu.

To stop a running script click on the Halt button or the ESC key.

To play the script fullscreen:

+ Click on the Run Script Fullscreen button in the ribbon bar.
The IconAnimate window is removed from view and the script runs fullscreen. To stop a script running 
fullscreen click on the esc key.

Note: You can achieve the same results by choosing Animation Fullscreen from the Run menu.



Disabling and Enabling Icons
IconAnimate lets you play a subset of the icons in a script by disabling icons that you do not want to run. 

To disable icons:

1. Open the Properties dialog box.
2. Select the icons that you want to disable.

To select one icon click on it. To select a contiguous series of icons, click on the first icon in the series, 
press and hold the SHIFT key, and click on the last icon in the series. To select a non-contiguous 
group of icons, press and hold the CTRL key and click on the desired icons. 

3. In the Properties dialog box, make sure that the Common tab is showing and click to select the 
Disabled option.

4. Follow the instructions for running a script in the Display view or fullscreen, as described previously in 
this section



Saving New Animation Files
The first time you save an animation file you also name it.

To save a new animation file:

1. Choose Save As... from the File menu.
The Save As dialog box appears.

2. Enter the name you want to assign to the file in the File Name text box.
3. Choose OK.

The dialog box is removed and the name of the animation file appears in the title bar.



Saving Existing Animation Files
Periodically, it is a good idea to save changes to an animation file that has been saved previously, but 
now contains unsaved changes.

To save changes to an existing animation file:

 Choose Save from the File menu.
The animation file is saved automatically.



Saving and Renaming Animation Files
It is sometimes useful to save an animation file and rename it at the same time.    For example, you might 
want to make changes to an existing animation file called TRAIN1.ANI, but still keep a copy of it in its 
original state. You save and rename TRAIN1.ANI, with the name TRAIN2.ANI.    

You now have two identical animation files with different names.    Make as many changes as you like to 
TRAIN2.ANI and you will still have a copy of the original TRAIN1.ANI.

To save and rename an animation file:

1. Choose Save As... from the File menu.
The Save As dialog box appears.

2. Type the name you want to assign to the animation file in the File Name text box.
3. Choose OK.

The dialog box is removed and the new name of the animation file appears in the title bar.



Starting New Animation Files
When you first start IconAnimate, the Script view is blank.    You can begin building a new animation file 
immediately. You can also create a new animation file even if you already have an animation script 
currently visible in the window.

To start a new animation file:

+ Choose New from the File menu.
A new animation window appears within the IconAnimate window. Use commands in the Window 
menu to cascade or tile any windows that are open. 



Opening Existing Animation Files
To open an animation file:

1. Choose Open... from the File menu.
2. Select the name of the file you want to open.
3. Click on OK.

The animation file is opened.



Path Information and IconAnimate
When you access IconAnimate, by default, it assumes you are working with files (graphics and 
animations) located in the paths defined in your master IAUTHOR.PTH file.    If you are creating an 
animation for an application that uses paths other than those in IAUTHOR.PTH, choose Path File...    from
the Options menu to select an alternative .PTH file for IconAnimate to use. When you choose Path File... 
the Path File dialog box appears.

The File Name field contains the path and filename of the current .PTH file. Use the Browse... button to 
specify an alternative .PTH file. Use the Edit... button to open, view, and optionally edit a path file in 
Notepad.

Once you specify an alternative .PTH file, IconAnimate will know where to find and store the animation 
and graphics files for that application. If you select a file that is not in the directory specified in the .PTH 
file, IconAnimate displays a message asking if you want to copy the file to the necessary directory.



Quitting IconAnimate
When you are ready to end your work session, you can quit IconAnimate.

To quit IconAnimate:

+ Choose Exit from the File menu.
If you choose exit and have not yet saved the file you are working on, a dialog box appears and asks if
you want to save the changes to the file.

To exit without saving changes:

+ Choose No.
To exit and save changes:

1. Choose Yes.
If the file you are saving has been saved (named) on a previous occasion, it is saved automatically. If 
the file has not been saved before (it is "untitled"), a Save As dialog box appears.

2. Enter a filename in the File Name text box.
3. Choose OK.

The file is saved and IconAnimate is closed.



File Menu
New
Start a new animation script.

Related Topic:

Starting New IconAnimate Files

Open... 
Opens an existing animation file.

Related Topic:

Opening Existing IconAnimate Files

Save
Saves an existing animation file with the same name.

Related Topic:

Saving Existing IconAnimate Files

Save As...
Allows you to save and name an animation file for the first time, or to save and rename an existing 
animation file.

Related Topic:

Saving and Renaming IconAnimate Files

Save All
Saves all open animation files.

Delete
Deletes the active animation file.

Page Setup...
Sets the top, bottom, left and right margins and specifies information to be included in the header and 
footer of a printed page.

Print Setup...
Allows you to select a print driver and a printer connection.

Print Preview
Allows you to preview what the file will look like when printed.

Print...
Allows you to print the current file.

Recent File
Displays a list of the most recently opened files. Select from the list to immediately open a file.

Exit
Exits and closes IconAnimate. Lets you save unsaved changes before quitting.

Related Topic:

Quitting IconAnimate



Edit Menu
Undo
Reverses the last action you performed.

Redo
Reverses the last Undo action you performed.

Cut
Removes the selected icons from the animation script and puts them on the Clipboard.

Related Topic:

Cutting Icons

Copy
Places a copy of the selected icons on the Clipboard.

Related Topic:

Copying Icons

Paste
Lets you paste the icons on the Clipboard into the script.

Related Topic:

Pasting Icons

Delete
Removes the selected icons from the animation script without placing them on the Clipboard.

Related Topic:

Deleting Icons

Select All
Selects all icons in the current script.

Related Topic:

Selecting Icons

Properties...
Displays the Properties dialog box which lets you set the properties for the currently selected icon.

Related Topic:

Setting Properties



Run Menu
Animation in Display View
Plays the script in the Script View

Related Topic:

Playing the Entire Script

Animation Full Screen
Plays the script fullscreen. 

Related Topic:

Playing the Entire Script

Selected Icon
Plays the selected icon.

Related Topic:

Playing a Single Icon

Stop Animation
Stops the script from playing.



View Menu
Toolbar
Check this option to display the Toolbar.

Status Bar
Check this option to display the Status Bar.

Icon Palette
Check this option to display the Icon Palette.

Zoom
Displays a cascading menu of commands that zoom or un-zoom the Work or Display areas.

25%, 50%, 100%, 200%, 300%
Zooms the information in the active view to the selected %

Fit To View
Compresses or expands the information so that it fits within the view.

Clear
Removes any information in the active view.

Maximize
Maximizes the active view.

Tile
Displays all three views.

Related Topic:

IconAnimate Window

Show Locks
Display any locks you have set in the Display view.

Related Topic:

Lock Icon



Options Menu
Path File...
Displays the Path File dialog box which lets you set the .PTH file for IconAnimate to use.

Related Topic:

Path Information

Display Size...
Lets you set the dimensions of the animation file. The default is fullscreen.

Auto Arrange Views
Check this option for IconAnimate to use the default settings for how the three views are arranged on the 
screen.

Confirm Icon Delete
Check this option to cause IconAnimate to confirm whether you want to delete the selected icon when you
press DELETE or choose Delete from the Edit menu.

Save Settings Now
Saves information about the IconAnimate window setup.



Window Menu
Cascade
Rearranges the open animation file windows so that they overlap and each title bar is visible.

Tile Horizontally
Rearranges the open animation file windows horizontally so that all are visible in the work space.

Tile Vertically
Rearranges the open animation file windows vertically so that all are visible in the work space.

Close All
Closes all of the open animation file windows. Asks if you want to save a file if it contains unsaved 
changes.



Help Menu
Index
Displays a list of available Help topics.

Using Help
Displays a short tutorial and other information about using online help.

About IconAnimate...
Displays IconAnimate copyright and version information.



Common Tab Properties
The Common tab shows the properties that are common to all IconAnimate icons.

Comments field
All icons let you specify comments about the role of the icon within the script. Use the keyboard to type a 
brief explanation. The comments that you enter appear in the script.

Disabled check box
This option is deselected by default. When you select it, the icon is greyed and is not executed when you 
run the script from within IconAnimate. 



Properties for Multiple Selected Icons
If you select multiple icons in a script with the Properties dialog box open, the Disabled property is the 
only option that appears. This option is deselected by default. When you click on the option to turn it on, 
the selected icons are grayed and are not executed when you run the script from within IconAnimate.



Animate Icon
Animates a portion of the graphic image (that is in the Work view) within the Display view.

Note: Precede the Animate icon with a Graphic icon to load the image into the Work view.

Suggested Uses:
+ Consecutively display the same image at different locations on the screen, causing the image to 

appear as if it is moving. For example, use this process to make an arrow move across the screen to 
point to a particular area.
Consecutively display slightly different images at different locations on the screen. For example, you 
can have a person waving good-bye by animating two or three images, each with the person's hand in 
a different position.

Tabs
General
Look
Mask
Common



Animate Icon - General Tab
The General tab contains the following fields:

Work Width, Height field
Work Locations field
Display Locations field



Work Width,Height field
The goal is to define the size (width and height) of the image or images that you want to animate. First, 
you precede the Animate icon with a Graphic icon to load the graphic into the Work view. Then you 
specify the width and height of the image or images you want to animate.

Typically, you either select a value from the drop-down list or draw a box around the appropriate portion of
the image in the Work view. For example, you can draw a box that is 100 pixels wide and 200 pixels high. 
When you finish drawing, these values are automatically entered in the Work Width, Height field for you.

Related Topics:

Animating an Entire Graphic
Animating Part of a Graphic
Animating Multiple Images in Sequence



Work Width, Height - Animating an Entire Graphic
In some cases you may want to animate an entire graphic. For example, if the entire image consists of a 
space shuttle that you want to move across the screen, you would specify the full width and height of the 
image. For your convenience, the drop-down list box contains the full width and height for the image that 
is currently showing in the Work view.



Work Width, Height - Animating Part of a Graphic
You may want to animate just part of a graphic in the Work view. For example, perhaps you have a 
graphic that contains several items, only one of which you want to animate. In this case you would specify
just the width and height necessary to enclose the desired item.

To specify just part of an image, first load the image into the Work view using a Graphic icon. Once the 
image is visible you can use the mouse to specify the size of the area you want to animate. Move the 
cursor into the Work view.

Position the cursor above and to the left of the item you want to draw an area around. While pressing and 
holding the mouse button, draw a box around the area you want to animate.

When you finish drawing the box, release the left mouse button and the width and height are entered into 
the Width,Height box.



Work Width, Height - Animating Multiple Images in Sequence
The graphic you load into the Work view may contain multiple items that will all be part of one animation. 
As an example, a graphic file can contain four different views of a rolling ball. (Each ball is shaded 
differently.) You can put the four images together in one animation sequence to show the ball moving 
across the screen. In this type of situation, you only need to draw the box one time, around one of the 
balls.



Work Locations field
The image you want to animate is loaded into the Work view (because you used it to complete the Work 
Width, Height field). Now that you have identified the basic width and height of the area you want to 
animate, you must specify the precise position of the area or areas within the Work view that you want to 
animate. 

Use the mouse cursor to identify the parts of the Work view that you want to animate. Click in the Work 
Locations field and move the cursor into the Work view. Press and hold the left mouse button. The cursor 
is accompanied by a box that is the size that you specified in the Work Width,Height field. While still 
holding the mouse button, position the box over the part of the image you want to animate. Release the 
mouse button and the coordinates of the upper left corner of this box are returned to the Work Locations 
field.

Related Topics:

Animating a Single Image
Animating Multiple Images in Sequence



Work Locations field - Animating a Single Image
When you want to animate a single image, you only need to choose one Work Location. In some cases 
the image you are animating is the full width and height of the graphic in the Work view. For example, if 
you are animating an entire graphic, such as a picture of the space shuttle, you would position the box 
around the entire graphic and release the mouse button.

In another type of situation, although the graphic in the Work view may contain multiple images you may 
only want to animate one item. For example, a graphic may contain different sizes of arrow pointers. If 
you are only animating one of the arrow, you only need to select that particular arrow.



Work Locations field - Animating Multiple Images in Sequence
When you want to animate a series of images in sequence, such as different views of a rolling ball, you 
need to select each image from the Work view.

In this kind of situation you need to identify several separate locations within the Work view by going 
through the location selection process once for each image. Each time you select another location the 
new coordinates are added to the Work Locations list.

Note:    Eventually, when you play your script, any images identified in the Work Locations list are 
displayed at locations that you specify in the Display Locations list box. If you have a single Work 
Location, the same image is shown repeatedly. If you have multiple Work Locations (like four different 
views of a rolling ball) the images in the different Work locations are shown repeatedly in sequence.



Display Locations field
List the locations where the image or images (that you have selected from the Work view) will be 
displayed. These locations represent the upper left corner of the image or images being displayed. If you 
only want the image to appear in one position, select one location in the Display View. If you want the 
image to appear in several positions, select multiple locations.

To select a single location click on a point in the Display View. The point is entered in the Display 
Locations list box. Each subsequent click in the Display view enters another pair of coordinates in the list 
box.

Related Topics:

Animating Images in Place
Animating Images in a Straight Line
Animating Images in an Irregular Path



Display Locations field - Animating Images in Place
If you only select one Display Location, any images that you selected in the Work Locations field will 
appear at the single Display Location.

This technique is useful for showing an image moving in place. For example, you can use the Work 
Locations field to select four images of a wheel, each with slightly different shading. Then, if you specify 
just one Display Location, the four wheels will appear in sequence (repeatedly) in the same location. The 
wheel will appear to turn in place.

In order to successfully animate an item moving in place, you must specify how long you want the image 
to animate. To do this, use the Loop Time (sec.) field on the Look tab.



Display Locations field - Animating Images in a Straight Line
If you want an image to appear to travel from one point to another, select the first Display Location in the 
Display view and then select the second Display Location. As an example, to move an image from one 
side of the screen to the other, select one Display Location on the far left side of the Display view and 
another on the right side. When the animation runs, it doesn't just flash the image at these selected 
locations. It actually displays the image (or images) at regular intervals on the straight path between the 
two locations. (The Animate icon uses information you provide in the Smoothness field under the Look tab
to determine what intervals to use.)



Display Locations field - Animating Images in an Irregular Path
If you want an image to appear to move around the screen, hold down the Ctrl key, press the left mouse 
button and drag the mouse around the Display view. This technique enters many points along the 
specified path into the list box.



Animate Icon - Look Tab
The Look tab contains the following fields:

Smoothness field
Speed field
Loop Time (sec.) field
Image Trail option
Remove Last Image option



Smoothness field
Specify a keyword or number that denotes the degree of smoothness or coarseness you want in your 
animation. Use the drop-down list to select a keyword.

Acceptable Values
A keyword or a whole number (such as 5 or 10). A whole number indicates the number of actual display 
points on the straight path between selected Display Locations.

Valid keywords
VerySmooth Coarse
Smooth VeryCoarse
Medium



Speed field
Specify a keyword or number that denotes the speed with which you want the animation to display. Use 
the drop-down list to select a keyword.

Acceptable Values
A keyword or a whole number (such as 100 or 250). A whole number indicates the number of milliseconds
between each actual display point on the straight path between selected Display Locations. As an 
example, 250 (ms) causes a 1/4 second pause between each display of an image being animated.

Valid keywords
VerySlow Fast
Slow VeryFast
Medium



Image Trail option
Select the Image Trail option to cause a portion of each image that is displayed as part of the animation to
remain on the screen.



Loop Time (sec.) option
By default, an Animate icon will run from the first Display Location to the last and then stop. If you set a 
Loop Time the icon will cycle through the Display Locations (or Location) until the Loop Time expires. If 
the time specified is shorter than the time necessary for the Animate icon to finish, then the animation 
sequence is cut off before it completes.

This field is useful when you animate images that use just one Display Location. For example, if you are 
animating a ball rolling in place it would use multiple images of the ball, but only one Display Location. 
Without a Loop Time, the first image of the ball would appear and the animation would end. In contrast, if 
you use a 10 second Loop Time, the ball appears to roll in place for because the same Display Location is
used over and over.

Acceptable Values
A positive, real number such as 3 or 7.2.



Remove Last Image
Select this option to remove the last image displayed during the animation sequence. If this box is not 
selected the last image remains on the screen.



Animate Icon - Mask Tab
A key feature of the Animate icon is its ability to let you mask part of the graphic to make the animation 
appear more realistic. Masking is the process of hiding unwanted portions of an image you are animating.

As an example, consider how you might animate a graphic of a space shuttle. Although you are interested
in animating just the shuttle, the graphic file is rectangular and a background surrounds the shuttle. In 
order to successfully animate just the shuttle you need to mask out the background.

The fields and options of the Mask tab let you choose from one of three masking methods: Color 
masking, Coordinate masking, or Polygon masking. Because it is considerably easier, the recommended 
method is Color masking.

Important: You only need to use one of these methods and each method uses different fields. If you 
provide values for more than one kind of masking, the information will be used in the following order of 
precedence: Color masking, Coordinate masking, and then Polygon masking.

The Mask tab contains the following fields:

Color field (for Color masking)
Work Locations field (for Coordinate masking)
Work Polygons field (for Polygon masking)
Offset Polygon option (for Polygon masking)



Color field
The easiest way to create a mask is to specify a particular color you want to make transparent when the 
Animate icon executes. 

Important: Do not use the mask color in any part of the graphic that you do not want to be transparent.

Acceptable Values
A keyword or an RGB value.

Valid keywords
Any color name that is available from the Color drop-down list of the Solid Color dialog box. Click on the 
Color... button to display the Solid Color dialog box. When you choose a color from this box, the 
corresponding RGB value is returned to the Color field.



Work Locations field
In coordinate masking you create a specially designed graphic that contains its own mask. This kind of 
graphic actually contains side-by-side images: the image you want to animate on the left and a mask for 
that image on the right. This masking method is recommended when color masking cannot be used, that 
is, when all of the solid colors in your palette are present in the graphic being animated. This leaves no 
color available to be specified as transparent.

In the Work Locations box you specify the position that marks the upper left corner of the mask part of the
graphic. If you are using a graphic that contains several images and their masks, you would specify 
multiple mask positions.

To enter mask positions, move the cursor into the Work view and press and hold the left mouse button. A 
box that represents the Work Width,Height value that you specified under the General tab is displayed. 
Drag the box so that it overlaps the mask. When you release the mouse button, the upper left corner of 
the mask is returned to the Work Locations field. If you choose multiple mask positions, they are added to
the field in sequence.



Work Polygons field
Polygon masking lets you draw a polygon around the object or objects (in the Work view) that you want to
animate. In general, to draw a polygon mask you:

1. Use a Graphic icon to load the image to be animated into the Work view.
2. Build and open an Animate icon.
3. Fill in all the necessary data in fields in the General and Look tabs.
4. Click on the Mask tab.
5. Click in the Work Polygons box.
6. Move the cursor into the Work view.
7. Click on a point on the perimeter of the item you are animating.
8. Click on another point on the perimeter of the object to draw a line that begins to surround the object.
9. Continue clicking on points on the perimeter until you almost completely surround the object.
10.Double-click to close the surrounding polygon.

The coordinates of the points that you selected are entered in the Polygon list box. Repeat the process
for additional items that you want to mask.

The polygon masking process varies slightly depending on the type of animation you are creating. Here 
are some general rules:

* You can animate one object across the screen. In this situation you simply draw a polygon mask 
around the object.

* You can animate multiple versions of one item (like a bird in three different wing-flapping poses). In this
case you draw a separate polygon mask around each pose (double-click to complete each mask).

* You may want to animate multiple versions of one object (like a rolling ball in three different poses), 
where the object is exactly the same shape and size in each pose. You draw a polygon mask around 
the first object and then turn on the Offset Polygon option. The Offset feature causes IconAnimate to 
use the same polygon mask for each version of the object. The idea is that you can use the same 
mask repeatedly since the object is the same shape and size in each pose.



Offset Polygon option
When you turn on the Offset Polygon option IconAnimate uses the same polygon mask for each image 
that is part of the animation. The idea is that you can use the same Polygon mask repeatedly since the 
object is the same shape and size in each pose.



File Icon
The File icon allows you to run a previously created animation script file from within another animation 
script.

Suggested Uses:
+ Combine multiple animation scripts into one script.
+ Combining several short animation scripts using the File icon makes the animation scripts easier to 

manage.
Tabs
General
Common



File Icon - General Tab
File Name field
Specify the name of the animation (.ANI) file that you want to execute. To find the desired file, click on the 
Browse... button to open the Browser. Locate the filename and double-click on it. The filename is 
automatically returned to the File Name field.



Flash Icon
The Flash icon allows you to flash an area of the animation on and off. The flashed area can be any 
shape, and can be the entire area or just the border.

Suggested Use:

+ Flash an area of the animation to highlight images or text on the screen to catch the viewers attention.
Tabs
General
Look
Common



Flash Icon - General Tab
The General tab contains the following fields:

Flash Type field
Flash Data field



Flash Type field
Specify the type of region you want to flash:    Rectangle, Polygon or Rectangle.



Flash Data field
Specify the areas of the animation that you want to flash. The goal is to specify coordinates that describe 
one or more areas in the Display view. Rather than typing the numeric values, however, you simply draw 
the shapes you want to use. The values that correspond to the shapes are automatically entered in the 
Flash Data field for you.

Flashing Rectangles or Ellipses
To specify data for a rectangle or an ellipse:

1. Move the cursor into the Display view.
2. Position the cursor at the top left corner of the area you want to flash.
3. Press and hold the left mouse button.
4. Drag down and to the right to draw a box.

If you are drawing a ellipse, it will be just large enough to fit in the box. To draw a perfect square or 
circle, hold down the SHIFT key while you draw.

5. When the box is the correct size, release the mouse button.
The data that describes the position and dimensions of the shape is automatically returned to the Flash 
Data box. Repeat the process to specify additional rectangles or circles.

Flashing a Polygon
To specify data for a polygon:

1. Move the cursor into the Display view.
2. Click on a point on the perimeter of the area you want to flash.
3. Click on another point on the perimeter of the area to draw an imaginary line that begins to 
surround the object.
4. Continue clicking on points on the perimeter until you almost completely surround the area.
5. Double-click to close the surrounding polygon.
The coordinates of the points that you selected are entered in the Flash Data box. Only one polygon is 
accepted for this icon.



Flash Icon - Look Tab
The Look tab contains the following fields:

Border Width field
Flash Rate field
Number of Flashes field
Total Time (sec.) field
Invert Last Image option



Border Width field
Specify the width of the border you want to flash. The values indicate the width of the border in pixels. 
Acceptable values are a real number (such as 5 or 25) or variable. If left blank, the flash will be solid as 
opposed to just a border.



Flash Rate field
Specify the speed of the flash. Select a keyword from the drop-down list (such as SLOW, MEDIUM or 
FAST) or enter a numeric value. Numeric values represent milliseconds, therefore a value of 1000 results 
in a one second flash.



Number of Flashes field
Specify the number of times the display area flashes. The area flashes for the number of flashes specified
unless a value is entered in the Total Time text box. If both values are specified, then the area flashes for 
whatever action is completed first, either the number or the time. Acceptable values are a real number 
(such as 5 or 15) or variable.



Total Time (Sec) field
Specify the number of seconds the area flashes. Optionally, you can enter a decimal value in this field. 
The area flashes for the total time specified unless a value is entered in the Number of Flashes text box. If
both values are specified, then the area flashes for whatever action is completed first, either the number 
or the time.



Invert Last Image option
Select this option to specify the status of the flashed areas when the flash is complete. If the Invert Last 
Image option is selected, the areas remain reverse highlighted when the flashing is complete. If the option
is not selected, the areas return to the normal color when the flashing is complete.

To invert an area without a flash, specify zero for the number of flashes and select the Invert Last Image 
check box.



Flip Locks Icon
The Flip Locks icon reverses the locked and unlocked regions of the animation. To use this icon, simply 
build it into your script. When the icon executes, the current state of all existing locks is reversed.

Suggested Use:

+ Lock a full screen area around a single item. 
This icon uses only the common properties.

Example
Build a script that uses several Lock icons to lock regions near the center of the screen. Use an Animate 
icon to animate an item so that it moves across the screen. As the item moves    through the center of the 
screen, it cannot be seen in locked regions. Next, build a Flip Locks icon into the script, followed by 
another Animate icon. This time, when the item moves across the screen, the locked and unlocked areas 
are reversed. As a result, the item can only be seen in the regions near the center of the screen.



Graphic Icon
The Graphic icon loads a graphic file into the Work view and optionally displays it in the Display view.

Suggested Uses:

+ Display an entire graphic file in the animation.
+ Display part of a graphic file in the animation. (Use the Graphic icon to load the entire file into the Work

view and then transfer a portion to the Display view using a Transfer icon.)
+ Load a graphic file into the Work view and then use an Animate icon to animate the image.
Tabs
General
Effect
Common



Graphic Icon - General Tab
The General tab contains the following fields:

Filename field
Display Location field
Update the Display View option



File Name field
Specify the name of the graphic you want to display. To locate a file, click on the Browse... button to open 
the Browser. When you double-click on a filename it is automatically returned to the File Name field. Use 
a filename that uses one of the following formats:

.ATT .DIB .ICO .MAC .PSD .WPG

.BMP .EPS .IFF .MSP .RAS .XBM

.CAL .FIF .IMG .PCD .RLE .XPM

.CLP .GIF .JPG .PCT .TGA .XWD

.CUT .GX2 .KFX .PCX .TIF

.DCX .ICA .LV .PIC .WMF

Display Location field
If you want to load the graphic directly into the animation in its entirety, specify the position of the upper 
left corner of the file. The drop-down list lets you quickly select 0,0 (the top left corner of the screen) or 
another pair of coordinates that would automatically center the graphic. Otherwise, you can use the 
following procedure to select an alternative location.

To specify a location:

1. Make sure that the file specified in the File Name field is loaded into the Work view. If it is not, click on 
the Apply button.

2. Move the cursor into Display view.
3. Press and hold the left mouse button.

The cursor is accompanied by an rectangular outline that represents the graphic in the Work view.
4. Move the cursor so that the rectangle is in the desired location.
5. Release the mouse button.
The coordinates that described the upper left corner of the location are returned too the Display Location 
field.



Update the Display View
When this option is selected, the graphic is displayed directly into the Display view in its entirety. If you 
only want to load the graphic into the Work view, deselect this option. Typically, you only load a graphic 
into the Work view if you want to either transfer or animate an image using the Transfer and Animate 
icons, respectively.



Effect Tab
The Effect tab contains the following fields:

Effect field
Modifier field
Size field
Speed field

Rather than specifying individual values for these fields, click on the Effect... button to display the Effect 
Selector dialog box. This dialog box lets you select and preview special display effects. When you choose
OK to close the Effect Selector, the selected values are automatically returned to the Effect tab fields.

Note: If you do not choose an effect (or you leave the none values unchanged in the Effect Selector) the 
image immediately replaces the previous information on the screen.



Effect Selector
The easiest way to provide values for the fields on the Effect tab is to click on the Effect... button to 
display the Effect Selector.

Effect - This is the type of effect. Options in other fields change when you change the effect.

Modifier - This is the Direction in which the effect occurs.

Size - This is the size of the blocks, strips, etc. used in the effect. Use a keyword from the drop-down or 
enter a number of pixels.

Speed - This is the speed at which the effect occurs. Use a keyword from the drop-down or enter a 
number of seconds. If you select veryfast, the effect is performed as quickly as possible. Other keywords 
execute the effect progressively more slowly (fast, medium, slow, and veryslow).

The VeryFast keyword is the only value that is CPU-dependent. The other values will run at the same 
speed on all systems. If you enter a number of seconds for a VeryFast speed effect, IconAnimate 
attempts to complete the effect in the specified time. However, because the VeryFast speed capability is 
machine-dependent, the effect may take longer than the specified time. For example, if you enter 2 
seconds, but this is beyond the capabilities of your machine, the effect will take longer.

Preview Button - Click on the Preview button to preview an effect that you have chosen. (The effect is 
previewed using samples; it does not use the actual image you plan to display at runtime.)

Note: If you do not choose an effect (or you leave the none values unchanged in the Effect Selector) the 
image immediately replaces the previous information on the screen.

OK Button - Click on the OK button to automatically return the selected effect and parameters to the 
Effect fields.



Lock Icon
The Lock icon allows you to lock an area of the animation so that nothing can be displayed in that area 
until the area is unlocked. This icon is typically used to give an object a sense of depth or dimension.

Suggested Use:
+ Lock an area on the screen and then move an item across that area. The object appears to go behind 

the locked area. For example, your script animates a boat traveling across a lake. Lock an island on 
the lake so that the sailboat appears to go behind it.

Tabs
General
Common



General Tab
The General tab contains the following fields:

Lock Type field
Lock Data field



Lock Type field
Specify the type of region you want to lock (in the Lock icon) or unlock (in the Unlock icon): Rectangle, 
Polygon or Rectangle.



Lock Data field
Specify the areas of the animation that you want to lock (in the Lock icon) or unlock (in the Unlock icon). 
The goal is to specify coordinates that describe one or more areas in the Display view. Rather than typing 
the numeric values, however, you simply draw the shapes you want to use. The values that correspond to
the shapes are automatically entered in the Lock Data field for you.

Specifying Rectangles or Ellipses
To specify data for a rectangle or an ellipse:

1. Move the cursor into the Display view.
2. Position the cursor at the top left corner of the area you want to lock or unlock.
3. Press and hold the left mouse button.
4. Drag down and to the right to draw a box.

If you are drawing a ellipse, it will be just large enough to fit in the box. To draw a perfect square or 
circle, hold down the SHIFT key while you draw.

5. When the box is the correct size, release the mouse button.
The data that describes the position and dimensions of the shape is automatically returned to the Lock 
Data box. Repeat the process to specify additional rectangles or circles.

Specifying a Polygon
To specify data for a polygon:

1. Move the cursor into the Display view.
2. Click on a point on the perimeter of the area you want to lock or unlock.
3. Click on another point on the perimeter of the area to draw a line that begins to surround the object.
4. Continue clicking on points on the perimeter until you almost completely surround the area.
5. Double-click to close the surrounding polygon.
The coordinates of the points that you selected are entered in the Lock Data box. Only one polygon is 
accepted for this icon.

Unlocking a Specific Lock
The easiest way to unlock a previously locked part of the Display view is copy the exact values that were 
used in the original Lock icon.

To copy specific lock data from a preceding Lock icon:

1. Click on the Lock icon that sets up the lock you want to unlock.
2. Drag over the relevant values to select them.
3. Press Ctrl + Insert to copy the values to the Clipboard.
4. Click on the Unlock icon.
5. Click in the Lock Data field.
6. Press Shift + Insert to paste the values into the field.



Note Icon
The Note icon allows you to include comments in the script. Although all icons have a Comments field, the
Note icon lets you include comments that are not associated with a particular action in the script.

Comments field
Enter free-form text to save as notes and comments about the animation script. 



Paint Icon
The Paint icon allows you to paint (display) a color onto an area of the animation. Typically, you paint the 
entire animation with a color, but you have the option of painting just a part of it. Although it is most 
common to paint a color directly onto the animation, you can also choose to paint an area in the Work 
view and then use an Animate icon to animate the resulting color block within the animation.

Suggested Uses:
+ Display a color directly into the Display view to clear the screen at the beginning or between portions of

an animation script.
+ Remove an image from the screen by painting over it.
+ Load a color area into the Work view and then animate the colored rectangle or square.
Tabs
General
Effect
Common



Paint Icon - General Tab
The General tab contains the following fields:

Main Color field
Blend Color field
Width, Height field
Display Location field
Update the Display View option



Main Color
Specify the color you want to paint. You can type a common color name (such as blue or red) or specify 
an RGB value. The easiest way to select a color is to click in the Main Color field and click on the Color... 
button to display the Color dialog box. Select a color or create a custom color. When you click OK the 
color value is automatically returned to the Main Color field.



Blend Color
Optionally use this field to specify a second color that you want to use (along with the Main Color field) for
a blended display effect when the screen is painted. Click in the Blend Color field and click on the Color... 
button to display the Color dialog box. Select a color or create a custom color. When you click OK the 
color value is automatically returned to the Blend Color field.



Width, Height field
Define the width and height of the area to be painted. 

Painting the Entire Display View
To specify the full width and height of the Display view:

+ Choose the value that appears in the drop-down list.
This is the width and height of your screen. When you choose this value, IconAnimate automatically 
fills in the remaining fields. It sets the Display Location to 0,0 and it turns on the Update the Display 
View option.

Painting Part of the Display View
To specify a portion of the Display view:

+ Position the cursor in the Display view and draw a box representing the area to be painted.
When you finish drawing the box, IconAnimate automatically fills in the Width, Height field, Display 
Location field, and Update the Display View option.

Painting Part of the Work View
To specify a portion of the Work view:

+ Position the cursor in the Work view and draw a box representing the area to be painted.
When you finish drawing the box, IconAnimate automatically fills in the Width, Height field. The other 
fields are left blank because they only apply to the Display view.



Display Location 
If you want to paint the color directly into the animation, specify the starting position of the upper left 
corner of the color.

Painting the Entire Display View
To specify the full width and height of the Display view:

+ The easiest way is to go to the Width, Height field and choose the value that appears in the drop-down
list.
This is the width and height of your screen. When you choose this value, IconAnimate automatically 
fills in the remaining fields. It sets the Display Location to 0,0 and it turns on the Update the Display 
View option.

Painting Part of the Display View
To specify a portion of the Display view:

+ Position the cursor in the Display view and draw a box representing the area to be painted.
When you finish drawing the box, IconAnimate automatically fills in the Width, Height field, Display 
Location field, and Update the Display View option.



Update the Display View
When this option is selected, the color is painted directly into the Display view. If you only want to paint 
the color into the Work view, deselect this option. Typically, you only load an area of color into the Work 
view if you want to subsequently use an Animate icon to animate the color area.



Pause Icon
The Pause icon allows you to pause the animation script for a specified time period.

Suggested Use:
+ Pause the animation during a tutorial to allow the viewer time to read the instructions.
Tabs
General
Common



Pause Icon - General Tab
This tab contains the following field:

Wait Time (sec)
Specify the number of seconds you want the animation script to pause. Use a real number greater than 0 
(such as 5 or 6.5).



Stop Icon
The Stop icon lets you stop the animation script at any point during the animation and resume the 
animation when one of three things occurs: a specified time has elapses, the user has clicked, or the user
has pressed a key. 

You can set up the icon up to respond to any number of these options. For example, you can set it up to 
wait only for a mouse click or to wait for a mouse click or a key press. If you set up the icon to accept 
multiple events, it will respond to whichever event occurs first.

Suggested Use:
+ Stop the animation periodically to allow the viewer to control the pace of the script.
Tabs
General
Common



Stop Icon - General Tab
This tab contains the following fields:

Wait Time (sec) field
Optionally, specify a timeout period in seconds. Enter any real number (such as 5 or 6.5). If you want the 
animation script to wait only for a mouse click or a key press, leave this field blank.

Continue on Mouse Click option
Select this option to stop the animation script until the user clicks the left mouse button. 

Continue on Keyboard Input option.
Select this option to stop the animation script until the user presses any key on the keyboard.



Transfer Icon
The Transfer icon allows you to transfer a portion of the graphic image that is in the Work view to the 
Display view.

Note: Precede the Transfer icon with a Graphic icon to load the image (to be transferred) into the Work 
view.

Suggested Use:
+ Transfer multiple images from a single graphic file to the Display view at different times, with different 

display effects, and at locations other than the original location.
Tabs
General
Effect
Common



Transfer Icon - General Tab
The General tab contains the following fields:

Work Area field
Display Location field



Work Area field
Specify the portion of the image in the Work view that you want to transfer to the Display view. The 
graphic must previously have been loaded into the Work view via a Graphic icon.

The easiest way to specify the area you want to transfer is to draw a box around the appropriate portion 
of the graphic in the Work view. When you finish drawing the box, the values that describe the selected 
area are automatically returned to the Work area field.



Display Location
Specify the Display view position where you want to display the image that is transferred from the Work 
view. The easiest way to specify    this location is to first enter a value in the Work Area field. Then position
the cursor in the Display view and press and hold the mouse button. The cursor is accompanied by a box 
that represents the area that you specified in the Work Area field. Move the cursor to position the box. 
When the box is in place, release the mouse button and the corresponding coordinates are returned to 
the Display Location field.



Unlock Icon
The Unlock icon allows you to unlock an area in the Display view so that an image can be displayed at 
that location. This icon should be placed on the script sometime after the Lock icon.

Suggested Use:
+ Unlock an area on the screen that was previously locked so that subsequent images can be displayed 

on that area of the screen.
Tabs
General
Common



Unlock Icon - General Tab
The General tab contains the following fields:

Lock Type field
Lock Data field



Lock Type
Specify the type of region you want to unlock:    Rectangle, Polygon or Rectangle.



Lock Data
Specify the areas of the animation that you want to unlock. The goal is to specify coordinates that 
describe one or more previously locked areas in the Display view. There are two common ways to do this.
You can draw an area in the Display view. Or, you can open a previously created Lock icon, take note of a
specific previously locked area and copy those values to the Unlock icon.

Unlocking a Rectangle or Ellipse
To draw a rectangle or an ellipse:

1. Move the cursor into the Display view.
2. Position the cursor at the top left corner of the area you want to unlock.
3. Press and hold the left mouse button.
4. Drag down and to the right to draw a box.

If you are drawing a ellipse, it will be just large enough to fit in the box. To draw a perfect square or 
circle, hold down the SHIFT key while you draw.

5. When the box is the correct size, release the mouse button.
The data that describes the position and dimensions of the shape is automatically returned to the Lock 
Data box. Repeat the process to specify additional rectangles or circles.

Unlocking a Polygon
To draw a polygon:

1. Move the cursor into the Display view.
2. Click on a point on the perimeter of the area you want to unlock.
3. Click on another point on the perimeter of the area to draw an imaginary line that begins to surround 

the object.
4. Continue clicking on points on the perimeter until you almost completely surround the area.
5. Double-click to close the surrounding polygon.
The coordinates of the points that you selected are entered in the Lock Data box. Only one polygon is 
accepted for this icon.

Important: You can also draw a polygon by holding down the Ctrl key and moving the mouse. You can 
intersperse this action with the clicking action described above.

Unlocking a Specific Lock
To copy specific lock data from a preceding Lock icon:

1. Click on the Lock icon that sets up the lock you want to unlock.
2. Drag over the relevant values to select them.
3. Press Ctrl + Insert to copy the values to the Clipboard.
4. Click on the Unlock icon.
5. Click in the Lock Data field.
6. Press Shift + Insert to paste the values into the field.



File Open dialog box
This dialog box lets you open an existing IconAnimate (*.ANI) file.

To open a file:

1. Make sure the dialog box is looking in the right place for the file you want.
The current path appears below "Directories." Use the Drives drop-down list box to change to another 
drive and use the Directories list box to change to another directory. Double-click on a closed directory
folder to open it. When a folder is open the files in that directory (that match the filter in the File Name 
field) appear below the File Name field.    

2. When the correct file appears in the File Name list, double-click on the filename.



File Save As dialog box
Use the Save As dialog box to save a new file or to save and rename an existing file.

To save a file:

1. Make sure the dialog box is pointing to the right drive and directory. 
The current path appears below "Directories." Use the Drives drop-down list box to change to another 
drive and use the Directories list box to change to another directory. Double-click on a closed directory
folder to open it. When a folder is open the files in that directory (that match the filter in the File Name 
text box) appear below the File Name text box. 

2. When the dialog box is pointing to the right directory, specify the name you want to assign to the file.
Choose an item in the File Name list box or type a new filename into the File Name field.

3. Click on OK.



Page Setup dialog box
Use the Page Setup dialog box to set the margin and header/footer settings for printing. Current margin 
settings are indicated in the four boxes to the top, bottom, left, and right of the page symbol in the Margins
area.

To reset margins:

1. Click in the appropriate box in the Margins area and enter a new value.
2. Choose OK.
When you setup headers and footers you specify the kind of information to be included and how that 
information will be formatted. For example, you might include today's date and right justify it in the header.
Headers and footers are always printed within the top and bottom margins, respectively. By default, the 
current filename appears as the header, and the word "Page" followed by a page number appears as the 
footer. Both items are centered on the page.

To setup headers and footers:

+ Use the Header and Footer text boxes to enter text and/or any codes you want to appear at the top 
and bottom of each page.

For example, you can type the word "Date" followed by a space and &d in the Header text box. This 
generates text such as "Date 12/15/91" at the top of the printed page. (Include spaces in your definition if 
you want them to appear between items.)

Use the following codes to generate and format information in the Header and Footer text boxes:

Code: Result:
&d Generates the current date.
&p Generates page numbers.
&f Generates the current filename.
&l Justifies the text that follows at the left margin.
&r Justifies the text that follows at the right margin.
&c Centers the text that follows.
&t Generates the current time.



Print Setup dialog box
If you already have one or more printers installed on your system, you can use IconAuthor to select and 
configure the printer you want to use. For detailed information on how to configure a printer, see the 
User's Guide for your windowing system.

Note: Because other programs also let you perform printer setup, it is possible that the appropriate printer
is already selected and configured.



Print dialog box
Use the Print dialog box to specify which pages of an animation file you want to print and how many 
copies you need of each page. 



Properties dialog box
Each icon has a dialog box associated with it that enables you to edit the properties (characteristics) of 
each icon. You open a Properties dialog box by double-clicking on an icon in the script. The dialog box 
contains all of the fields and options for the selected icon.

The Properties dialog box has different tabs to let you display and edit different properties. When you 
finish working on the currently selected icon, you can either click on the Close button or click on a 
different icon in the script. When you click on another icon, the fields and settings change to reflect the 
current icon.

You set properties for the icons within a script to customize the way they perform. For example, when you
use the Graphic icon, you can display a particular graphic. You can set properties such as the name of the
file and the screen location to use for the file.

To open the Properties dialog box:

+ Double-click on an icon in the Script view.
Note: You can also open the dialog box by selecting an icon and pressing ALT + ENTER. Or, by right 
clicking in the Script view and choosing Properties... from the popup menu.

Once the Properties dialog box is open, you can click on another icon in the script and the dialog box 
changes to reflect the currently selected icon. The dialog box remains open until you explicitly close it.

Related Topics:

How Tabs Work
Buttons in the Properties Dialog Box
Entering Values in the Properties Dialog Box



Path File dialog box
When you access IconAnimate, by default, it assumes you are working with files (graphics and 
animations) located in the paths defined in your master IAUTHOR.PTH file.    If you are creating an 
animation for an application that uses paths other than those in IAUTHOR.PTH, use the Path File dialog 
box to select an alternative .PTH file for IconAnimate to use.

The File Name field contains the path and filename of the current .PTH file. Use the Browse... button to 
specify an alternative .PTH file. Use the Edit... button to open, view, and optionally edit a path file in 
Notepad.

Once you specify an alternative .PTH file, IconAnimate will know where to find and store the animation 
and graphics files for that application. If you select a file that is not in the directory specified in the .PTH 
file, IconAnimate displays a message asking if you want to copy the file to the necessary directory.



Display Size dialog box
The Display Size dialog box lets you set the dimensions of the animation file. The default is fullscreen. If 
you change the display size and decide to return to the fullscreen dimensions of the current system, click 
on the Screen Size button.



About IconAnimate dialog box
This dialog box displays IconAnimate copyright and version information.



Color dialog box
To choose a basic color:

1. Select one of the 48 color cells in the Basic Colors palette.
2. Choose OK to accept the change or choose Cancel to dismiss the dialog box without accepting 

changes.
To choose a custom color:

1. Click on the Define Custom Colors... button in the Colors dialog box.
The Color is extended to show the custom color selector.

2. Click on an empty cell in the Custom Colors area.
3. Drag the color refiner cursor to the area of the color refiner box that shows the color you want to use. 

Then drag the arrow next to the vertical luminosity bar up or down to adjust the luminosity.
As you change the color, the new color is displayed on the left side of the Color/Solid box. The right 
side of the box displays the solid color closest to your choice. If you want to select the solid color, 
double-click on the right side of the box.

4. When you are satisfied with the color, click on the Add to Custom Colors button. 
The color is added to the selected cell.

5. Define any other colors you want to add to the palette and choose OK to accept the changes and close
the Colors dialog box.



New command
Starts a new animation script.

Related Topic:

Starting New IconAnimate Files



Open... command
Opens an existing animation file.

Related Topic:

Opening Existing IconAnimate Files



Save command
Saves an existing animation file with the same name.

Related Topic:

Saving Existing IconAnimate Files



Save As... command
Allows you to save and name an animation file for the first time, or to save and rename an existing 
animation file.

Related Topic:

Saving and Renaming IconAnimate Files



Save All command
Saves all open animation files.



Delete command
Deletes the active animation file.



Page Setup... command
Sets the top, bottom, left and right margins and specifies information to be included in the header and 
footer of a printed page.



Print Setup... command
Allows you to select a print driver and a printer connection.



Print Preview command
Allows you to preview what the file will look like when printed.



Print... command
Allows you to print the current file.



1st Recent File command
Displays the most recently opened file. Select the item to immediately open the file.



2nd Recent File command
Displays the second most recently opened file. Select the item to immediately open the file.



3rd Recent File command
Displays the third most recently opened file. Select the item to immediately open the file.



4th Recent File command
Displays the fourth most recently opened file. Select the item to immediately open the file.



Exit command
Exits and closes IconAnimate. Lets you save unsaved changes before quitting.

Related Topic:

Quitting IconAnimate



Undo command
Reverses the last action you performed.



Redo command
Reverses the last Undo action you performed.



Cut command
Removes the selected icons from the animation script and puts them on the Clipboard.

Related Topic:

Cutting Icons



Copy command
Places a copy of the selected icons on the Clipboard.

Related Topic:

Copying Icons



Paste command
Lets you paste the icons on the Clipboard into the script.

Related Topic:

Pasting Icons



Delete command
Removes the selected icons from the animation script without placing them on the Clipboard.

Related Topic:

Deleting Icons



Select All command
Selects all icons in the current script.

Related Topic:

Selecting Icons



Properties... command
Displays the Properties dialog box which lets you set the properties for the currently selected icon.

Related Topic:

Setting Properties



Animation in Display View command
Plays the script in the Script View

Related Topic:

Playing the Entire Script



Animation Full Screen command
Plays the script fullscreen. 

Related Topic:

Playing the Entire Script



Selected Icon command
Plays the selected icon.

Related Topic:

Playing a Single Icon



Stop Animation command
Stops the script from playing.



Toolbar command
Check this option to display the Toolbar.



Status Bar command
Check this option to display the Status Bar.



Icon Palette command
Check this option to display the Icon Palette.



25% command
Zooms the information in the active view to 25%



50% command
Zooms the information in the active view to 50%



100% command
Zooms the information in the active view to 100%



200% command
Zooms the information in the active view to 200%



300% command
Zooms the information in the active view to 300%



Fit To View command
Compresses or expands the information so that it fits within the view.



Clear command
Removes any information in the active view.



Maximize command
Maximizes the active view.



Tile command
Displays all three views.

Related Topic:

IconAnimate Window



Show Locks command
Display any locks you have set in the Display view.

Related Topic:

Lock Icon



Path File... command
Displays the Path File dialog box which lets you set the .PTH file for IconAnimate to use.

Related Topic:

Path Information



Display Size... command
Lets you set the dimensions of the animation file. The default is fullscreen.



Auto Arrange Views command
Check this option for IconAnimate to use the default settings for how the three views are arranged on the 
screen.



Confirm Icon Delete command
Check this option to cause IconAnimate to confirm whether you want to delete the selected icon when you
press DELETE or choose Delete from the Edit menu.



Save Settings Now command
Saves information about the IconAnimate window setup.



Cascade command
Rearranges the open animation file windows so that they overlap and each title bar is visible.



Tile Horizontally command
Rearranges the open animation file windows horizontally so that all are visible in the work space.



Tile Vertically command
Rearranges the open animation file windows vertically so that all are visible in the work space.



Close All command
Closes all of the open animation file windows. Asks if you want to save a file if it contains unsaved 
changes.



Index command
Displays a list of available Help topics.



Using Help command
Displays a short tutorial and other information about using online help.



About IconAnimate... command
Displays IconAnimate copyright and version information.



Activate Script View button
This button makes the Script view the active part of the animation window. This is particularly useful if you
have maximized one of the other views and want to switch to the maximized Script view.



Activate Work View button
This button makes the Work view the active part of the animation window. This is particularly useful if you 
have maximized one of the other views and want to switch to the maximized Work view.



Activate Display View button
This button makes the Display view the active part of the animation window. This is particularly useful if 
you have maximized one of the other views and want to switch to the maximized Display view.




